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Computer

Preface

: Computers is a comprehensive series of eight books designed specifically

for the needs and requirements of the students studying in classes 1-8. This
series perfectly complies with the NCERT syllabus criteria and the National
Curriculum Framework's vision. In keeping with NEP 2020’s guidelines, the
series adopts an interactive approach to make it possible for the learners to
enjoy computers. This book includes enough questions in accordance with
the NEP criteria. The fundamental principles of NEP which are recognizing,
identifying and fostering the unique capabilities of each student, respect
for diversity, and consideration for the local context in all topics, are always
kept in mind while framing the book.

The topics are introduced in a way that children experience and learn
through exploration.

Child-friendly language and contextual images have been incorporated
throughout the series to make the material more understandable for young
readers. This allows them to connect what they read and relate it to the
views, ideas, and experiences they encounter every day.

Salient Features of the series:

Learning Outcomes

Warm Up
Teacher’s note
Let me answer

Do You know
Remember It

Kids’ 1Q

Up skill your
Intelligence
Critical Thinking
Team Work

: It guides both the teacher and the students towards the correct direction

of efficient learning. It establishes the path of learning for efficient and
superior learning results.

: Children can connect their prior knowledge to the chapter's topic through

simple yet engaging activities.

An outline of guidelines for teachers to follow in the classroom in order to
make lessons interactive and discussion-based.

: Questions related to the topic which are essential for checking pupil

understanding and keeping them engaged with the task at hand.

: An interesting piece of information related to the topic.

: Additional information about the topic to encourage children to wonder

about various surroundings.

: These questions have been included to reinforce learners to think,analyse

and apply.

: Ample exercises with a range of questions to support learning.

: Questions which allow the learners to think clearly and rationally.

: It enables the students to collaborate with others.

The content is structured and well graded. Sincere efforts have been made
to prevent any inconsistencies and make this series a perfect complement
to the students' education. Any worthwhile recommendations for the
improvement of the series are always welcome and greatly appreciated.

Author



FOCUS AREAS

Learning Outcomes

It shows the right path of learning
to the teacher as well as students. It
establishes the direction of learning
for efficient and superior learning
results.

- Teacher’s Note:

An outline of guidelines
for teachers to follow in
the classroom in order to
make lessons interactive
and discussion-based.

Let's Recall

It aids in providing a brief
summary of the entire chapter.




OF NEP 2020

Critical Thinking

Questions which allow the learners
to think clearly and rationally.
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¥  HARDWARE AND SOFTWARE

At the end of this chapter, students will be able to :

+ Differentiate between hardware and software.

+ Define the main parts of the computer.

+ Classify the computer parts into input, output and storage devices.
+ Learn about the working of all parts of the computer in detail.

Identify and circle the name of the things you cannot see and touch.

Wind Paper Fan
Sound Chair Computer

Apprise students that something which a person can see, feel or touch and have a physical
TP existence are called tangible things, whereas the intangible is something which a person
2\/3 cannot see, feel or touch and thus does not have any of the above mentioned features of

physical existence.

«g Teacher’s




Hello... we already know about the
basics of computer. Now, we will
learn about the functions of each
part of the computer in detail.

Now, it is time to learn more about
this wonderful machine.

KEY PARTS OF A COMPUTER

We already know that a computer is an electronic device that can do
many tasks simultaneously. A computer system has different parts
that together make it work. Based on processing, computer parts are
divided into two groups :

A
<« >

Hardware

Software

HARDWARE

The parts of the computer that can be seen and touched are called
hardware. Hardware refers to all electronic and mechanical parts of
the computer system.

Further, computer hardware parts are classified as follows.
Input devices
< Output devices

Storage devices




Input Devices

A Computer always needs a set of instructions to work. It cannot
work on its own. The devices through which instructions are fed into
the computer system are called Input devices. For example, Keyboard
is used to give instructions to the computer by typing.

Other input devices are a mouse, microphone, web camera, light pen
and joystick.

KEYBOARD

Keyboard is the most common input
device. Data and instructions are entered
into the computer using its keys. There are
different layouts of keyboards available,
like QWERTY, WASD, and DVORAK.
Amongst these, QWERTY is the most
commonly used layout. WASD keyboard
is mostly used by gamers.

A keyboard has different types of keys. These keys are small buttons

on the keyboard keys.

Some of the important keys are :

Alphabetical keys : A, B, C.....Z are alphabet keys. There are 26
alphabet keys.

Numerical keys : 1,2....are numerical keys. There are 10
numerical keys.

ol
<% & Do You Know?
Some Keyboards Are Designed for Thumb usage. On most keyboards, you type using all your fingers.

There are some keyboards, however, that are designed specifically for thumb usage known as thumb-
sized keyboards. They were popular during the early 2000s.




Spacebar

Backspace

Arrow keys

Alphabetical keys

MOUSE

: 'This key is used to insert space between the

letters. It is the longest key on the keyboard.

: 'This key is used to delete any character before

the current position of the cursor.

: These keys are used to move the cursor position

in all directions

Backspace Numerical keys

Spacebar Arrow keys

A computer mouse is an input device that is used
with a computer. It is a pointing device that can
move the cursor to different items on the screen. A
mouse has two buttons, the left button and the right

button, with a scroll wheel. Today, many

Differentiate between a house| computers use wireless technology and have
mouse and a computer’s mouse.

no wire.

There are two types of mouse namely wired and wireless.

A wired mouse

: A wired mouse is the type that has a

wire. It is connected to a computer
or a laptop directly. The transfer of information
takes place through the wire

o




Wireless mouse : It does not have any wire. It is not
connected directly to any system. The
transfer of information takes place in
the form of radio signals.

Optical mouse : An optical mouse uses a light-
emitting diode (LED). Movement
is detected by sensing changes in
the reflected light.

MICROPHONE

Microphone is an input device that is used to
record any sound or voice. It converts sound into
an electrical signal.

WEB CAMERA

A webcam is a camera that connects
to the computer and captures still
pictures or motion videos.

LIGHT PEN
A lightpen is a light-sensitive pointing input device
that is used to draw things on the computer screen.

Can you do video calling on
a PC using a web camera?

SCANNER

A scanner is an input device that is used to scan
any document and print it on paper. We can also
save the document on the computer.

Output Devices

MONITOR
A monitor is an output device that shows the work which we do on

o




a computer. It also displays the result and movement of the mouse
pointer on the screen. It is also known as VDU(Visual Display Unit).

There are three types of monitors

1. CRT (Cathode Ray Tube)

These monitors are big in size and consume more power.

2. LCD (Liquid Crystal Display)

These are the monitors with flat screens with low power consumption.
3. LED (Light Emitting Diode)

These monitors have a better display. They are thinner and lighter in
weight. They consume 40 per cent less power than LCD.

CRT monitor LCD monitor LED monitor

PRINTER

It is a hardware output device that allows a user to print items on
paper. Many printers can also work as photocopiers.

Laser printers

Laser Printers produce high-quality text and graphics. To print text
and images onto the paper, it uses a focused beam of light.

Laser printer Inkjet printer Solid ink printer

o




Inkjet printers

These are also called bubble jet printers and print both text documents
and high-quality coloured images, especially photos. These are cost-

effective as compared to laser printers.
PROJECTOR

A projector is an output device that takes images
generated by the computer and displays them on
a big screen.

Storage Devices

HARD DRIVE

It is a storage device and has flat circular plates
made of aluminium or glass that can store huge

amount of data.

DVD

It stands for Digital Versatile Disk. It is used for
data storage, recording, and to play audios and

videos.
Pen Drive

It is also known as a USB stick that uses
flash memory and can store a lot of data and
applications.It is also used to copy and move

data from one computer system to another.
Memory card

It is a small chip-like device that stores electronic data.
It can also be inserted into a smartphone.

o




Processing Devices

CPU

CPU stands for Central Processing
Unit. It is also called the brain of the
computer as most of the functioning
of the computer takes place in this
part. It also controls all the other parts
of the computer.CPU has three parts

Arithmetic and logic unit (ALU)

This unit is responsible for all the arithmetic and logical operations
of the computer.

Memory unit (MU)

Thisunitisresponsible for storingall the information on the computer.
The memory can be volatile or non-volatile.

Control Unit (CU)

This unit controls the functioning of all the other units such as MU,
ALU and devices.

REMEMBER IT! /&

The CPU sends signals to control the other parts of the computer, almost like how
a brain controls a body.

Software

Softwares are the applications stored in the computer that we cannot
see and touch. These are the set of instructions, data or programs
that enables computers to work. Examples of software are MS excel,
MS Word, Tux Paint and many more.

The software can be of two types:

o




SYSTEM SOFTWARE

System software is designed to run a computer’s hardware and
provides a platform for applications to run. E.g. Operating System

APPLICATION SOFTWARE

An application is a software that fulfils a specific need or performs
tasks. Example : Paint, Excel, Games, Word etc.

Microsoft Excel Microsoft Word
T,:{:ﬁh\‘; Kids’ | Q
Write T for input devices and ‘O’ for the output devices.
Keyboard D Microphone D Printer D
Let’s Recall !

o The parts of computer system are divided into two groups namely : hardware
and software.

o Hardware means those parts of the computer that we can see and touch.

o Software includes the applications of the computer that we cannot touch and see.
o Hardware is further classified into Input, Output and Storage devices.

« Software is classified as system software and application software.

« Monitor, printer, speaker and projector are output devices.

« Keyboard, mouse, microphone, and web camera are input devices.

o Hard drives, DVDs, and USB drives are storage devices.

¢




A. Identify and name the following storage devices.

B. Fill in the blanks.

| (T Software is designed to run computer’s hardware and
provides a platform for applications.

2. CPUstandsfor ....cccooevvn...

3. can also work as photocopiers.
4. monitors consume 40 per cent less power than LCDs.
5. captures still pictures and motion videos.

C. Answer the following questions.

1. What are output devices? Explain with examples.

2.

3.




4.

AR S e

Explain any two storage devices.

--------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------

AU —
DV D e,
CR T = e
LE D e
LD = e

E. Write ‘T’ for True statements and ‘F’ for False statements.

.l

ALU stands for arithmetic and logic units.

There are 10 alphabet keys on a keyboard.

Mouse and microphone are output devices.

)
)
Laser and Inkjet are the types of printers. (]
()
)

CRT, LED and LCD are the types of monitors.

F. Tick the correct answers.

1.

Which is not hardware?

() a. Keyboard () b. Mouse

() c. Monitor () d. Microsoft Excel
Which is not a type of monitor screen?

() a. LED ([ ) b.LCD () c.CRT () d. ALU

.................... takes images generated by a computer and displays them
on a big screen.

() a. Projector [ ) b. Hard drive( ] c. Monitor [ ) d.Light pen

@




Which is not a part of the CPU?
() a ALU () b.CU ( JcCRT [ Jd.MU

This software fulfils a specific need or performs tasks.
() a. Application( ) b. System (] c. Speaker () d.Hard Drive

@g Critical Thinking

A. Whoam I?

1.

3.
4.
5.

[ am the most commonly used layout of the keyboard.

[ am responsible for all the arithmetic and logical operations of the
computer.

CRT, LED and LCD are my types. e,
I can show images on the big screen. ...
ALU, CU and MU are my parts. .,

B. Identify the devices below and classify them as Input, Output and
Storage devices.

-------

---------------------------------------------------------------------------------------------------------

-----------------------------------------------------------------------------------




Team Work

Assess which of the following devices are present in your computer
lab. Use the lines below to write the names of the devices. Also, draw
pictures of the same.

Type of Mouse @ ..o,

Type of Printer @ ...,

Type of Monitor @ ...,

4 N\ )

\ J L J
( )




-4 CLASSIFICATION OF
- COMPUTERS

(o] WIEaqninoloutcomes

At the end of this chapter, the students will be able to:

+ Identity and explain the classification of computers based on size and
power.

+ Comprehend the use of different types of computers.

Look at the following pictures and number them out according to their sizes in
ascending order.

) U

‘¥ Teacher’s With the help of the above activity, inform students that the computers can be classified
2\ LR ) e basis of the size and power.

D




Hi! I am peter. 1 will introduce you to another
classification of computers. We have already read
about the hardware and software parts of the
computer in the last chapter. Now, we will classify
the computers on the basis of size and power.

CLASSIFICATION OF COMPUTERS BASED ON SIZE
AND POWER

On the basis of size and power, Computers are classified into the
following types:

Micro Computers Workstation Computers Mini Computers Mainframe Computers Supercomputers

MICRO COMPUTERS

These computers are minimal storage capacity
computers. They are commonly used in offices,
homes, shops etc. They are also referred to as
Personal Computers. For e.g. H.P. PC.

Micro Computers are further ;%T Do You Know?
divided into the following types: [

First mechanical computer was steam-powered.




Desktop Computer

Desktop computer is a personal computer
designed for regular use at a single location.
It has a monitor, keyboard and a mouse
attached with wires.

It also consists of UPS that helps us to work on the computer for
some time even when electricity is cut off.

Laptop Computer

A Laptop computer or notebook computer is
a highly portable computer that can be carried
easily in a briefcase. Its size is smaller than a
desktop computer and runs on battery which can
be recharged.

Tablet Computer

Which type of computers are
there at your home?

A tablet computer is a small, flat computer
that is operated by touching the screen. We
can also write on it by using a pen called Stylus.
It is smaller than a regular laptop and larger than
a cell phone. It can be used for sending emails,
watching movies, listening to music, etc.

REMEMBER IT! &

UPS stands for Uninterrupted Power Supply.
WORKSTATION COMPUTER

Workstation computers, also known as
desktop machines are used for intensive
graphical applications. They have more
processor speed than personal computers.

e




MINI COMPUTERS

Mini computer are more expensive and more
powerful than microcomputers but smaller,
cheaper and less powerful than supercomputers.
It is a multi-threaded system. Mini computers
are used in industries and for scientific purposes.
An example of a mini-computer is PDP-8.

SUPERCOMPUTER

Supercomputers are the most powerful
digital computers. They are capable of
handling huge amounts of calculations
thatare beyond human capabilities. They
are usually thousands of times faster
than any other computer. They are used for weather forecasting,
space research and satellite control. An example of a supercomputer
-

is PARAM BRAHMA.

CLASSIFICATIONOFCOMPUTERS }What if we were governed by
ON DATA PROCESSING SPEED supercomputers?

DIGITAL COMPUTERS

These computers are the most commonly
used. It calculates the numbers and does
logical operations. The main components
of digital computers are input, process and
output called the IPO cycle. They run on
electronic signs and binary systems 0 and 1.
Desktops, laptops and tablets are examples
of digital computers.

2




ANALOG COMPUTERS

An analog computer is a computer which is
used to process the continuously changing
data. They are used to measure and perform
arithmetic calculations of numbers, the
length of an object etc. They cannot store

statistics. An example of an analog computer
is IBM SYSTEM / 7.

HYBRID COMPUTERS

Hybrid computers are complex computer
units built using both analog and digital
properties and united by a single control
system. These computers are used in
scientific applications, aeroplanes, ships,
and hospitals.

An example of a hybrid computer is HY DAC 2400.

?Z’ﬁ“\“i Kids’ 1Q

Can you name the first Indian supercomputer?

& Let’s Recall |

« Computers can be classified on the basis of size and power.

o On the basis of size and power, computers are classified as micro computers,
mini computers, mainframe computers and supercomputers.

« On the basis of data processing speed, computers are classified as digital
computers, analog computers and hybrid computers.

o An example of Analog Computer is IBM system / 7.

o Hybrid computers have the best features of Analog and Digital computers.

e




A. Number the following computers in descending order based on their

sizes.

e Laptop computer :]
e Mini computer :j
e Supercomputer D
» Smartphone :J
o Desktop computer :]

B. Fill in the blanks.

Lo i computer is minimal in size and storage.
2. computers are used in scientific applications.
3. A computer is a flat, small computer that has a small

touchscreen display.
4o computers run on electronic signs and binary data.
5. HYDAC 2400 is an example of ................... computer.
C. Answer the following questions.

1. Explain the classification of computers on the basis of size and power

with the help of a diagram.




2. Explain Mini computers with examples.

--------------------------------------------------------------------------------------------------------------------

D. Write ‘T’ for True statements and ‘F’ for False statements.

1. Supercomputers can handle calculations that are beyond
human capabilities.

Analog computers can measure the length of an object.

Hybrid computer systems have multiple control systems.

ARl

Hybrid computers contain the best features of both analog

)
)
PDP-8 is a supercomputer. (]
)
)

and digital computers.

E. Tick the correct answers.

1. Computers are classified on the basis of sizeand .....................
() a. Speed () b. Power () c. Material
2. computers can be carried easily in a briefcase.
() a. Workstation (] b. Super () c. Laptop

D




3.  Workstations are mostly used for
() a. Weather Forecasting [ |b.Intensive Graphical Applications
() c. Making a Call

4. computers are also referred to as personal computer.
() a. Micro () b. Mini () c. Super

5. Tablets and Laptops are the examples of .................. computer.
() a. Digital () b. Analog () c. Hybrid

F. There are some characteristics given in one row and devices in the

other row. Match the devices with their characteristics.

1. UPS multi threaded system

2. Tablet are used for weather forecasting.

3. Workstations can make computer work without
electricity.

4. Supercomputers are also known as desktop
machines.

5. Mini computers works with a pen called stylus.

@E Critical Thinking

A. Mrs Peter owns a chain of Schools. Now, she is thinking to open a
school in a rural area. Also, she wants to install 15 computers in her
school for the computer lab. Suggest to her the type of computers she
should buy for the new school.

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo




B. Follow the instructions and colour the following computers on the
basis of data processing speed.

Laptop HYDAC IBM
2400 System / 7

Hybrid computer Digital Computer Analog Computer
y p g p g p

Team Work

Find about the first Mechanical Computer and paste its picture below.

4 )




7 LEARNING ABOUT WINDOWS 10

Learning]Outcomes

At the end of this chapter, students will be able to :
+ Describe an operating system.

+ Learn and write the features of W indows 10.

+ Explain the taskbar and windows accessories.
+ Change the desktop appearance and screensaver.

Number the following steps to switch on a computer system in proper order.

- -

BT R Apprise students that as we always need a clear set of instructions to complete a particular
2\ | [ICHR  task, similarly computer also needs instruction to work with accuracy.

o




Hello friends! I am peter. As we need a proper
set of instructions to complete the task with
accuracy, in the same way, for computers to
work with accuracy, they have a special set of
programs known as an Operating system.

AN OPERATING SYSTEM

A computer can complete various tasks simultaneously with
complete accuracy. Have you ever thought about how a computer
can do this?

Ability of a computer to carry out all of its functions depends on a
unique set of programs. These special sets of programs are known
as the operating system ( OS ). An operating system is a software
that helps us to work on a computer system. It is the most important

e
part of the computer system. For e.g. (£ & Do You Know?
Linux, GM-NAA, MAC, Android and | GM-NAA was the first operating system

used for real work.

Microsoft windows.

Microsoft Windows is the most commonly used operating system
developed by Microsoft Corporation. It is a Graphical User Interface-
based operating system. There are various versions of Windows
namely Windows XP, Windows 7, Windows 10 etc.

Let us study in detail about Windows 10.

?




FEATURES OF WINDOWS 10

» In Windows 10, multiple users can work on one computer system
at the same time.

» The search tool of Windows 10 is called Cortana, which lets
us search for any information on the system or on the internet

directly.

» It also provides the feature of downloading free and paid apps
from an application called the Microsoft Store.

» We can open numerous desktops simultaneously by using the
task view button.

PARTS OF WINDOWS 10
Desktop

It is the first screen which appears on the monitor whenever a
computer system is turned on. We can use our computer for work
once the desktop appears.

Current Desktop




Icons

Icons are the small stamp-like pictures on the screen that represents
a file, a folder or a program. An icon can be opened by double-
clicking on it.

Examples:

Icon of recycle bin Icon of This PC

Apps

Apps are small programs that
provide quick information.
These are the softwares that
allow you to perform specific
tasks. Any app can be searched
by typing its name in Cortana.

Start Button Figure 3.2: Desktop App

It is the most widely used button (7

on the Windows desktop. The

Is there any app that you have downloaded ever?

Start button in Windows 10 is a
small button that displays the Windows logo and is always
displayed at the left end of the taskbar. When the start
button is clicked, two panels open side by side. One panel
displays a list of apps arranged in alphabetical order, and
the other displays the latest updates.

Recycle Bin

It temporarily stores the

deleted items from the

Discuss the difference between a garbage
bin and a recycle bin in computers.

computer before they are

permanently deleted.




Windows Taskbar

The long horizontal bar which is present at the bottom of the desktop
is called Taskbar. Various parts of the taskbar are the start button,
middle section, quick launch toolbar and system tray.

The start button is found on the left side of the taskbar. Next to the
start button is the search box called Cortana. Next to Cortana is the
middle section. It shows programs and files we have opened and
allows us to switch between them quickly. These programs can be
opened with a single click.The system tray shows the data, time and
various other notifications.

Start button Open and pinned programmes Time and date
Cortana, Run and Search Figure 3.3: Windows Taskbar Notification Area

ACCESSORIES OF WINDOWS 10

The windows operating system comes with some useful tools called
Accessories. They are available in all versions of Windows.

Steps to open Accessories
o Click on the start button.
o Click on All Apps icon on the toolbar.

e Choose WindowsAccessories.
Let us discuss some essential Windows Accessories.

Calculator

The calculator is an app that performs arithmetic
calculations such as add, subtract and scientific

calculations.

Figure 3.4: Calculator App




Notepad

Notepad is a basic text editing tool

developed by Microsoft Windows. It

allows us to create, edit and print a

document. We can also save a file in the

Notepad app. Figure 3.5: Notepad

Windows Media Player

Windows Media Player is an application
that allows us to play audio,video files
and view images.

Other accessories are Paint, Wordpad

and many more. 7 Figure 3.6: Windows Media Player
ReMemBER IT! G
| Window Media player allows you to create your own playlist.

ALTERING THE SCREEN APPEARANCE IN WINDOWS

Ifyou have noticed, you would have found that all the applications and
data on a computer screen look in a particular way. This is because of
the default settings of Windows. We can change the default settings.
It can be done either by changing the wallpaper or screensaver or

both.
Changing the Wallpaper

Wallpaper is the background picture that appears on the desktop
screen. It is also known as desktop wallpaper.
We can change the desktop wallpaper using the following steps.

Steps:
1. Right-click on empty space on the desktop. A shortcut menu will

appear.
(34
]




2. Click personalise. This option is at the bottom of the drop-down
menu.

3. Click the box beneath the ‘Background’ Select the desired picture.

Setting the Screen Saver gf Do You Know?

There are some pre-installed wallpapers on
the computer system.

The Screen Saver is a software
program that becomes activated after

the computer remains inactive for a specified period of time.

We can change the Screen Saver using the following steps.

Steps:
1. Right-click on empty space on the desktop.

2. A shortcut menu will open.

3. Click the personalise option. This option is at the bottom of the
drop-down menu.

4. Select the Screen Saver option.

5. Click on the desired Screen Saver and click on the Apply option.
T%‘»‘ Kids’ 1Q
Find and name the OPERATING SYSTEM used:

a. Onyour school computer : ...
b. At your Father’s Office L

c. Atyour home computer @ ...

N J
' ’
& Let’s Recall
» An operating System is a software that acts as an interface between the computer
and us.

o« There are several features of Windows 10.

o The First screen that appears on a computer system is called the Desktop.

o Taskbar is present at the bottom of the desktop.

o Icons are small stamp-like pictures on the screen that represent programs.

« We can change the screen appearance in windows by changing its wallpaper

and screen saver.




: W Ups

A. Label the parts shown in the diagram.

B. Fill in the blanks.

1. Windowsisa ............... User Interface program.

2.  From the Microsoft Store, we can download free and ...................
Apps.

.................... and ...




C. Answer the following questions.

1.  What is an Operating System? Explain with examples.

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

D. Write ‘T’ for True statements and ‘F’ for False statements.
1. Taskbar is present at the upper part of the desktop.
2. We cannot change the screen appearance in Windows 10.
3.  Windows media player is used to view images only.
4. Icons are stamp-like pictures.
5

Linux is an operating system.

9

--------

--------

--------

--------

--------



E. Match the following.

1. LINUX are searched in cortona.

2. Calculator is an operating system.

3. System tray can do addition and subtraction.
4. Middle section shows the date and time.

5. Apps is next to Cortana.

é@g Critical Thinking

A. Harsh deleted a file two days ago. Now, he wants to retrieve that file.
Which application or icon will help him to do this task?

-----------------------------------------------------------------------------------------------------------------------------

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

B. Complete the following Operating Systems.

1. _ A__
2. _IN__ __

3. G_-N
I Team Work

Search for information on Forests using the Windows Search Tool -
Cortana. Write 5 lines on the topic in space given below.

.............................................................................................................................
.............................................................................................................................
.............................................................................................................................
.............................................................................................................................




" TEXT EDITING IN
- MICROSOFT WORD 2016

Learning]Outcomes
At the end of this chapter, students will be able to :
+ Understand different components of Word.

+ Know about Undo and Redo Commands.
+ Recognise various methods to select the text for editing.

Observe the logo of the following word processor and write five things you know
about it.

Apprise students that MS word is a potent word processor. Take students to the computer
2\ N PYPYR  [ab and tell students to type 5 lines about their favourite festival. Elucidate them to save

the file.
39
]
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Hello friends! You studied MS |
WORD 2016 in the previous
class. Now, lets discover more

features of MS WORD.

THE BASICS OF MS WORD

One of the most widely used word processors
produced by Microsoft Corporation is Microsoft
Word. We can quickly and conveniently create, read,
change, and share files. It comes in the Word 2010,
Word 2013, Word 2016, and Word 2019 versions.
The following are the uses of MS Word 2016.

» It allows you to copy and move the text from one location to
another.

» It permits you to create letters, resumes, and notices in an orderly
manner.

» It lets you edit the text after typing.

» It enables you to preview the text before printing.

VARIOUS COMPONENTS OF MS WORD
Quick Access Toolbar

The Quick Access Toolbar is a command line that appears on the
top-left corner of the MS Word window. From this toolbar, we can

o




quickly perform some tasks like Save @8
and Undo/Redo. This toolbar can be

£ % Do You Know?

) ] To create a shortcut of Word 2016, drag
customised to our needs and gives |itsicon to the Desktop.

access to frequently used features and
functions such as quick print, open recent files, etc.

Quick Access Tabs Title Bar Ribbon
Toolbar

Document Area

Status Bar zoom slider

Figure 4.1: MS Word Components

Title Bar

The Title bar is next to the quick access toolbar. It shows the name
of the document which is opened. By default, the name of any new
Word document is Document].

Tabs

The buttons located below the quick access toolbar and the title bar
are tabs. The most widely used tabs are the Home tab, Insert tab,
design tab, Layout tab, Mailings tab and Review tab. The Home tab

o




is the default tab in Microsoft Word. It has five groups of related
commands; Clipboard, Font, Paragraph, Styles and Editing.

Ribbon

It is below the tab buttons. All the seven tabs in the ribbon have a
specific group of related commands. The image given below shows
the commands under the Insert tab. Several functions, such as adding
shapes, text box, clipart, cover page, header and footer, etc., can be
inserted into a document using these commands.

Figure 4.2: Ribbon

Document Area

The document area is the blank or white section of the MS Word that
allows the user to create a content. When a document is opened,
you can begin typing, and your text appears in the document. When
a saved document is opened, the text is already present and we can
edit the text.

Status Bar

The status bar is the area at the bottom of the Word window that
indicates information about the current document. It displays
information about which page you are on, your line number, and
your character number on the line. It also shows the total number of
words in the document as well as the language used in the text.

Zoom Slider

It is in the lower right corner of MS Word. It is available for zooming

o




in and out of documents quickly and easily. The * + ° sign is clicked
to zoom in on the document, and the ° - * sign is clicked to zoom out
of the document.

E B - I +
Figure 4.3: Zoom Slider

HOW TO TYPE IN MS WORD

=)
=
&

What points do you keep in

Points to remember while typing. mind while writing?

1. Leave one space between words.
2. Enter to be pressed only after completing a line or a paragraph.

3. Press the shift key and the alphabet key to type capital letters.
Alternatively, we can turn on the Caps Lock key, type the letter,
and then press the key once again to turn it off.

4. Always remember to save your file after some time.

Selecting Text

If we want to make changes in the text we type, such as text style,
colour, size, alignment, etc., then we need to select the line, word, or
paragraph we want to edit.

Selecting a Word

To select a single word, quickly double-click
that word. Alternatively, place the cursor at
the beginning and drag the mouse pointer

over the word.
Figure 4.4: Selecting a Word

Selecting Line

A line in a document can be selected in following ways.

A
<« >

To select a line of text, place your cursor at the start of the line,

o




and press Shift + down arrow or place
the cursor at the beginning of the line
and drag the pointer over the line.

< Set the mouse pointer at the beginning,
of a line then click the left mouse button.  Figure 4.5: Selecting a Line

Selecting a Paragraph

We can select a paragraph in a
document by clicking on a text
section three times with the left
mouse button.

Selecting the Entire Document

Figure 4.6: Selecting a Paragraph
The whole document can be selected by placing the cursor at the

initial of the document and pressing Ctrl + A or by pressing the Shift
+ Ctrl + End key combination.

UNDO AND REDO COMMANDS
Undo Actions

Undo erases the last change done to the
document, reverting it to an older state.

< Click Undo on the Quick Access
toolbar.

- ¥ Format Painter

A

+ If you want to undo multiple steps,
press Undo (or CTRL+Z) repeatedly. Figure 4.7: Undo Action

Redo Actions

What do you do when you make a
mistake while writing with a pen?

The redo command restores what we had

just done.
]




<+ If you want to redo an action you
have undone, click Redo on the Quick
Access Toolbar.

Deleting the text

Past
A line, word or a paragraph in the - FormatPainter | ©
document can be deleted in the following Figure 4.8: Redo Action
ways.

< Press the delete key while the cursor is positioned to the left of
the letter or character you want to remove. The right-side text is
deleted by using the Delete key.

< Select the word you want to delete, then press the delete key.

< Ifyou want to delete a paragraph, select the paragraph by clicking
thrice and pressing the delete key.

REMEMBER I1T! &

Press Ctrl + Delete and Ctrl + Backspace key combinations to delete one word to
the right or left respectively.

/:.{\‘»' Kids’ 1Q

Raman was asked by his teacher to write paragraphs on Plants. However, he
wrote some irrelevant information as well. Now, the teacher has asked him to
delete that. How will you help him to do this?

! Let’s Recall !

Microsoft Word is one of the most popular word processors developed by
Microsoft Corporation.

e A Word Processor allows us to edit, insert and format the text.

o« MS Word components comprise of Quick Access Toolbar, Tabs, Ribbons,
Document Area, Zoom slider, Status bar, etc.

o Undo and Redo command reverses our last action and repeats our last action,

respectively.
]




A. Fill in the blanks.

1
2
3.
4
5

Microsoft Word is developed by ..........................

Wecan ..o, the text before printing.

The Title bar isnexttothe .............................

The Quick Access toolbarisa .......ccccocevvvevnennn. line.

The home tabisthe ............................ tab in Microsoft word.

B. Answer the following questions.

1.

What is the use of the Title Bar?

--------------------------------------------------------------------------------------------------------------------

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

Which component of MS Word allows you to zoom in or out of the
document?

oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo




C. Write ‘T’ for True statements and ‘F’ for False statements.
1. A zoom slider is the blank or white section of an MS word.
2. Mailings Tab is one of the most widely used tabs.

3. We can quickly perform some tasks like Undo/Redo from the
Quick Acces toolbar.

4. MS Word does not let you edit the text after typing.

5. By default, the name of any new word document is New.

D. Match the following.

1. Title Bar Blank Section

2. Ribbon Name of the document
3. Document Area Shift key + Alphabet key
4. Capital Letters Below the tab buttons

E. Label the components of the MS word.

Jou Uy



@} Critical Thinking

A. Neha has typed a letter in MS word to be submitted to her teacher.
Her sister came, and by mistake, she deleted the entire letter. Now,

which command should she use to get back the letter?

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

B. Find out the Tab name available in the MS word window in the grid
given below:

T L|A|Y|O|U|T]|TI

E| M| N|E| Q| F|A|N

M|A| TI|L|I|N|G]|S

O|S|D|P|B|N|C|E

H| X|W|E|I|V|E]|R

D/ E|S| 1 |G|N|E]|T
Team Work

Write a paragraph in MS Word on “My favourite Toy”. Save your
document with the name of your Toy. Take a printout of it and paste
it in your notebook.




J ~ FORMATTING IN MS WORD

Learning]Outcomes

At the end of this chapter, students will be able to :

+ Change the Font colour, style and font size of the text.
+ Apply text in alignment.

+ Add borders and shading effects to improve the appearance of the text.

Join the dots to find out the name of the word processor.

Ask the students about the features of MS Word 2016. Encourage them to remember and

2\ ('PYTYR  revise what they have learnt in the previous chapter: MS Word Components, Typing in
MS Word, Undo and Redo Commands and much more.

o
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Hello friends! You already know how editing
features of MS Word 2016 work. Let us learn
about a few formatting features that help our
document look presentable.

As we read in the previous chapter, Microsoft Word, developed by
Microsoft Corporation, is one of the most popular word processors

used worldwide. It allows us to create, edit, read and share files easily.

To make the document look presentable, we may change the
appearance. For it, we need to format the text, which means making

changes in the text and its appearance to make it look pleasing.

Features offered by MS Word to format the text are as follows.

<+ Font style, size and colour

P’
&% & Do You Know?

MS Word was first released on October 25,
1983, under the name Multi-Tool Word.

Text case and alignment

< Border and shading effect

FONT

A font refers to the size, design, colour and style of typed characters
within a document. To add variation to a document, we can use
different fonts, such as separate font styles for the heading and the
body. The Home Tab contains the Font settings. Following are the

options which are included in it:

o




Insert Design Layout References Mailings Review View Help Q Tell me what yo

Calibri Body) |11 -| A A Aa~ A

= v iz 3=
Paste . z | gL Ay AL Ezzg - | &
= ¥~ Format Painter B I U sbe X X [4 & =% = = =

Clipboard M Font Paragraph

Figure 5.1: Font Settings

We can press the Ctrl + Shift + F key combinations to open the Font
dialogue box.

Font Size

Font size increases or decreases the size of the characters. The size is
measured in points from 8 to 72. By default, the font size is 11.

Follow the given steps to change the font size of the text.

Steps :
1. Select the text you want to modify.

2. On the Home tab, click the drop-down arrow next to the Font
size box.

3. Select the desired font size.

4. 'The font size will change in the document.

Which font size would you suggest
for class 3 students?

Figure 5.2: Font Size
Font Colour

MS Word allows you to change the font colour of your text. If you
want to emphasise a particular word or phrase, you can change its
font colour. The default font colour in MS Word is black.

!




Follow the given steps to change the font colour of the text.

Steps :

1. Select the text whose colour you want to change.

2. On the Home tab, click the Font =
Color dr OP-dOWH arrow. The Font Which is your favourite colour? Why?
Color menu appears.

3. With the help of the mouse, select the font colour you want to
use. The font colour will change for the selected text.

4. Your colour choices are not limited to the drop-down menu that
appears. Select More Colors at the bottom of the menu to access the
Colors dialogue box. Choose the colour you want, then click OK.

Figure 5.3: Font Color

Font Style

We can also modify the font style. In MS Word, there are many
different font styles to choose from. The font style is set to Calibri by
default.

Follow the given steps to change the font style of the text.

&




Steps:

1. Select the text whose font style you
need to modity.

2. On the Home tab, click the drop-down
arrow next to the Font box. A menu of
font styles will appear.

3. Select the font style you want to use.

4. 'The font will change in the selected text.

REMEMBER IT!

It is estimated that MS Word is being used on
more than a billion devices worldwide.

|Aria| =11 ~|A A Aa~

Theme Fonts

Calibri Light {(Headings)
Calibri {Body)

All Fonts

Agency FB

ALGERIAN

Arial

Arial Black

Arial Narrow

Arial Rounded MT Bold
AventGarde Bk BT
Bahnschrift

Bzhnschrift Condensed
Bahnschrift Light
Bahnschrift Light Condensed
Bahnschrift Light SemiCondensed

A

Fy

Figure 5.4: Font Style

Making the text Bold, Italics and Underlined

You can highlight keywords or phrases using the Bold, Italic, and

Underline commands.

Follow the given steps to make the text Bold, Italics or Underlined.

Steps:

1. Select the text you want to modity.

2. On the Home tab, click the
Bold (B), Italic (I), or Underline
(U) command in the Font group.
Consider the example; click
Italics.

Figure 5.5: Text making Italics

3. The selected text will be modified in the document.

Bold: Ctrl + B key Italics: Ctrl + I key

Underline: Ctrl + U key

e




Text Alignment

The placement of the text within a page’s margins is referred to as
alignment.

There are four alignments as follows.

-

N

-

-

N

-

J

Left align Center align Right align Justify align

Left Alignment

It places the text towards the left margin. In Microsoft Word, the text
is left-aligned by default.

Shortcut key: Ctrl + L key
Right Alignment

It allows the text to align with the right margin. It is frequently used
to mention the date in a document.

Shortcut key: Ctrl + R key

Center Alignment

It aligns the text in the centre of the left and right margins. It is mainly
used with titles and headings.

Shortcut key: Ctrl + E key
Justify Alignment

It places the text evenly distributed between the leftand right margins.
It is significantly used for designing books and newspaper content.

Shortcut key: Ctrl + J key

e




How should text alignment be used?

Step 1: Select the text.

Step 2: Select the desired alignment button [:] [:j [:j (%J
on the Home tab in the Paragraph group.

Step 3: 'The selected text will be aligned.

Change Case

To change the appearance of the text, the change case option is used.
The change case menu offers five options:

Sentence case: The first
letter of each sentence is
capitalised.

Uppercase: All the letters of
the text are capitalised.

Lowercase: Text is changed
from UPPERCASE to Figure 5.6: Change Case
lowercase.

Capitalise Each Word: The first letter of each word is capitalised.

Toggle Case: Case of each and every letter in the sentence is reversed.
It will convert a letter written in uppercase to lowercase and vice-
versa.

Borders and Shading

To improve the appearance of the text, borders and shading effects
can also be added.

Follow the given steps to apply Borders and Shading.

Steps :
1. Select the paragraph(s) to which you want to add shading and

borders. @
]
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v Kids’ 1Q
Rahul wants to write a letter to inform his class teacher that he will not be able

to attend school because he is ill. Which ‘Case’ option should he use to write the
letter’s content?

Click the drop-down arrow next to border button and click
on the Border and Shading option.

Under the setting section, click on the box option.

Select the line style from
the style section and line
colour from the colour
drop-down list.

Borders and Shading

Borders

Page Border

Shading

Style: Preview

Click on diagram below or use
buttons to apply borders

|

Choose the line width
from the width drop-down
list.

Apply to:
Art: Whale document o

In apply section, select the T w0
paragraph option. Click

OK, and the border appears
around the text.

Figure 5.7: Border and Shading

----------------------------------------------------------------------------------------------------------------------------------------

Let’s Recall !

Formatting means changing the text appearance to make it look pleasing.

A font refers to the size, design, colour and style of typed characters within a
document.

The positioning of text on a page is referred to as text alignment.
Change case allows changing the text appearance case.

The change case options are Sentence case, Lowercase, Uppercase, Capitalise

Each Word and Toggle case.




W Upsk

A. Fill in the blanks.

Lo e, means changing the text appearance to make it
look pleasing.

2. The ., tab contains the font settings.

3.  We can press the Ctrl + shift + F key combinations to open the
............................ dialogue box.

4. 'The default font style in MS Word is ........c..ccccooenes

5 alignment evenly distributes the text between the

left and right margins.

B. Answer the following questions.

1.  What are the features offered by MS Word to format the text?

them.




5. Write the steps to make the text Bold.

--------------------------------------------------------------------------------------------------------------------

C. Write ‘T’ for True statements and ‘F’ for False statements.
1. A font is often measured in pixels.

Italics is used to tilt the text.

Sentence case makes the first letter of each sentence capital.

oo w0

The positioning of the text on a page is referred to as Text

)
)
Centre alignment is used significantly for designing books. (]
)
Alignment. )

D. Match the following.

1. Ctrl + R key {

—

2. Ctrl + B key

3. Ctrl + E key {

—

4. Ctrl + I key

5. Ctrl + L key { — }




E. Tick the correct answer.

1.

By default, text in MS Word is ................... aligned.
() a.Right () b.Centre [ ] c. Left () d. Justify

In which group ‘Bold, Italics and Underline’ commands are there?
() a. Font () b. Home () c. Insert () d. View
Which command do we press to tilt the text?

() a.Right (] b.Underline [ ] c. Italics () d.Bold

Ctrl +U key combination is the shortcut for ................. the text.
() a. Leftalign () b. Tilting () c.Underling ( ) d. Colouring
.................... alignment is frequently used for mentioning the date in

the document.

() a.Centre [ ] b.Right () c. Left () d. Justify

@g Critical Thinking

A. Number the following steps in order to change the font style of the

selected text:

The font will change in the selected text. ()

On the Home tab, click the drop-down arrow next to the Font box.
A menu of font styles will appear. .

Select the text whose font style you need to modify. [ |
Select the font style you want to use. ()

B. A book publishing house wants to align the text of the books. Help

the team by suggesting a suitable option which will complete their
task.




Team Work

all the editing and formatting skills you have learned.

Create a birthday invite for your friends in MS WORD 2016. Apply

(

N\

BIRTHDAY INVITE
Dear Ankit,

You are cordially invited to celebrate my birthday on Friday;,
29th July at 8:00 p.m.

Address : Sagar Apartment,

L 81, Moti Nagar Road
Contact Number : XXXX7352XX
PMIC

Your Name

~N




4 USING PAINT 3D

Learning]Outcomes
At the end of this chapter, students will be able to :

+ Utilise various drawing tools to make drawings in Paint 3D.
+ Differentiate between 2D and 3D shapes.

Draw a line to match the 3D Objects to their 2D look-alikes.

Apprise students that 2-D Shapes are plane or flat shapes, whereas 3-D Shapes are solid
figures that can be viewed from 3 directions: length, width and height. Also, show them
real objects such as Rubric cubes, balls, erasers, books, and many more.

@




Hello friends! In this chapter
let us learn about Paint 3D,
a brand-new and innovative
drawing programme.

All previous versions of Windows came with basic paint software
from Microsoft. A new Paint version, Paint 3D, is included in the
latest version of Windows 10. It is a free application with the addition
of creating and editing 3D images in a Paint program.

The application is comprehensive yet easy to use. By merging 2D
and 3D tools, it aids us in producing creative projects that are both
entertaining and professional. Anybody can use Paint 3D. Its user-
friendly interface makes it simpler to edit the already-created 3D

models and produce new ones. e

STARTING PAINT 3D APP Look around and tell the 2D and 3D

shapes present in your classroom.

Follow the given steps to start the Paint
3D app.

Steps:
1. Click on the start button.

2 —>

2. You can choose the Paint
3D option from the menu
or type Paint 3D in the
search box.

3. The paint 3D window will
open. 1 Figure 6.1: Starting Paint 3D

@




PAINT 3D INTERFACE

1 2 4 6

Figure 6.2: Paint 3D Interface

The Paint 3D window has the following elements.

1.

Menu: When you click on the expanded menu button, it opens a
variety of list options such as New, Save, Save as and many more

to perform multiple functions.

Brushes: The Brushes tool has different
brush types, which are used to draw lines

in various styles. It can be used to paint on
both 2D and 3D surfaces.

2D Shapes: This option is used to draw
2D shapes. This tool has many readymade
shapes such as Line, Rectangle, Stars,
Arrows, Triangle and many more.

@

2D shapes

Line and curve

S A AR

2D shapes

©C 0 O0A
OO0 ON &
A P Yooix <
009 8 &
¢« o ¥ O

Figure 6.3: 2D Shapes Tools



4. 3D Shapes: This option allows
to draw 3D shapes, such as cube,
cuboid, cat, woman, and many
other 3D shapes.

Figure 6.4: 3D Shapes

5. Stickers: With this tool, we can select
images from a ready-made image
collection and apply them as stickers
to our designs. The opacity of the
chosen and applied sticker can also
be changed.

Figure 6.5: Stickers

6. Text Tool: This tool allows to add
2D text or 3D text options in the
drawings.

Figure 6.6: Text Tools

7. 3D Library:Itisa collection of thousands
of free 3D models divided into several
categories.

o

Figure 6.7: 3D Library




8. Canvas: The canvas of the 3D Paint window is the area where
we can draw diftferent drawings.

BRUSHES IN PAINT 3D

In Paint 3D, brushes enable us to produce
stunning and distinctive designs. When the
Brushes tool is selected, ten brush options
appear in the right-side panel. We can adjust
or change thickness, opacity, material and
colour of the brush.

Step 1: Select a brush, click the left mouse
button at a starting point, and then
drag the mouse to create a line. Figure 6.8: Brushes in Paint 3D

Step 2: Use several brushes in various ways. Try out various options
for colours and thickness.

DRAWING 2D SHAPES

We can design excellent shapes with Paint 3D’s extensive library of
2D shapes. It also helps to create precise shapes using the line and
curve tools.

Follow the given steps to draw 2D Shapes in Paint 3D.
Steps:
1. Click on the 2D shapes option.

2. From the list of 2D Shapes,
select the square tool.

3. Place the mouse cursor on the

canvas.
Figure 6.9: Drawing 2D Shapes




4. When the mouse pointer turns into a ‘+ sign, drag it to make a
square.

5. Fill the colour to the square using the Fill group option.

T
(S
R

Which all shapes are there in
the 2D Shapes library?

DRAWING 3D SHAPES

This 3D shapes library option contains basic
3D doodles, 3D objects and 3D models to start drawing. 3D Doodle
tool lets you draw tabular, rounded and sharp-edged shapes. 3D
objects help you select the pre-defined 3D shapes like Cube, Spheres,

and many more. 3D models panel
contains 3D models like Man, Dogs, and | search any 3D object by typing

Fish its name in the search box.

Follow the given steps to draw 3D Shapes in Paint 3D.

Steps:
1. Select the 3D shapes option.

2. Click on the Tube tool from the given 3D shapes.

3. Place the mouse cursor on
the canvas.

4. When the mouse pointer
turns into a ‘+’ sign, drag it
to draw a tube.

5. Fill the colour in the tube
using the Edit Colour option. Figure 6.10: Drawing 3D Shapes




OPENING A PROJECT

To open a previously saved file or project, click on the open option
in the Menu tab.

Follow the given steps to open a saved project.

Steps:

1. Click expand menu button.
2. Click on the open option.
3. The open window will display a list of saved projects.
4. Select the desired saved projects from the list.
5. Click the Open button.
Figure 6.11: Opening a project
SAVING A PROJECT
Follow the given steps to save a é;f Do You Know?
drawing in Paint 3D. You can save your drawing by pressing
Ctrl + S key combination.
Steps:

1. Click Expand menu button.

@




2. Select the Save As option.
3. Type a name for your project.

4. Click the Save option.

Figure 6.12: Saving a Project

B} - )
x Kids’ 1Q
In paint 3D, Harshit created a science diagram. He is not able to draw a few

pictures in it. Think about the options you can provide him to get them from the
readymade picture gallery.

Let’s Recall !

« Paint 3D is a free application with the addition of creating and editing 3D
images in a Paint program.

o The Paint 3D window has elements like Menu, Brushes, 2D shapes, 3D shapes,
Stickers, Text tool, 3D Library and canvas.

« 3D shapes panel contains basic 3D doodles, 3D objects and 3D models to start
drawing.

o In Paint 3D, brushes enable us to produce stunning and distinctive designs.

 Text Tool allows adding 2D or 3D text options in drawings.

©




- Upskill Y.Intelligence =

A. Fill in the blanks.

1. To open a saved project, click on the .......................... tab.

2. The ., of the chosen and applied sticker can be changed.

3 s tool has many readymade shapes such as lines,
rectangle and triangle.

A tool allows to add 2D or 3D text in the drawings.

5 is the area where we can draw different drawings.

B. Answer the following questions.
1. What is Paint 3D?

....................................................................................................................
....................................................................................................................
....................................................................................................................
....................................................................................................................

C. Write ‘T’ for True statements and ‘F’ for False statements.
Paint 3D is a paid application.
Brushes tool has different brush types.

The Menu tab contains various options such as New, Save,

Save As, and many more. D
2D shapes option is used to draw a Circle, Star and Rectangle. (]

5. To draw a 3D shape, the mouse pointer turns into a ‘+’ sign.

©




D. Match the following.

1. 2D shapes

2. 3D shapes

3. Brushes

A. Anusha has created a 3D drawing in Paint 3D. She does not know

how to save the drawing she has made. Suggest to her the option to
fulfil this task.

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

Team Work

Pair up with your partners.
Draw a christmas tree in Paint
3D using different 3D Shapes.




4 INTRODUCING SCRATCH 3.0

E@% learning|0utcomes
At the end of this chapter, students will be able to :
+ Start the Scratch application.

+ Know difterent components of Scratch 3.0 window.
+ Draw shapes in Scratch.

Decode the colour bar and write the answer in the given spaces:

Codes:

A N L

U E
1 Pink
2 © Black
3 Pu_rple
4 Yellow G
5 Green
6 Black
7 Yellow G
8 Brown

‘W Teacher’s Apprise students that we use language to communicate with our friends and family,
in the same way, computers also use specific languages to understand our instructions

2\ Note:
which are called Programming Languages.




Hello friends! Do you know the name

of the language which computer

understands? What would you do to

make the computer understand your
instructions?

While communicating with other people, we always keep in mind
that he/she should know the language we are using to communicate.
Have you ever thought, how do we communicate with a computer?
Any commands we may give to a computer in English or any other
language are unknown to it. It requires a different set of languages to
understand theinstructions. Thelanguages the computer understands
are called programming languages, and Scratch is one of them.

For beginners, Scratch is an excellent visual programming language.
We can create interactive narratives, games, and animations. We can
give instructions to the computer using visual blocks.

R I
0

: . GRS
Let us now discover some fascinating &% @ Do You Know?
features of Scratch. A program in scratch is saved as a project.

FEATURES OF SCRATCH
< Scratch is freely available on the web.
+ 'The cartoon mascot of Scratch is a cat.
+ For a story, we can design our characters.

It can run well on various operating systems, including Windows,
Linux, and Mac OS.

@




Our favourite characters can be used to create games and
animations.

< We can share our stories and games made using scratch on the
web.

LET US START SCRATCH 3.0

2 —

Follow the given steps to run
the Scratch.

Steps :

1. Click on the start button.
2. Click the Scratch Application

: . 1 Figure 7.1: Starting Scratch 3.0
and its window opens.

Figure 7.2: Scratch Window




COMPONENTS OF SCRATCH 3.0

The following are the components of the Scratch window.

1.
2.

Title Bar - The title of the project you made is shown here.

Menu Bar - The menu bar has a variety of menus and icons,

including File, Edit, Tutorials, etc. ,

Script Area - Script area is where A scriptisalso calledaprogram.
you add blocks to write the script
for a sprite.

Sprite - Itis a tiny graphic that roams on the stage independently.
By including blocks to the script, we can control the sprite. A
new project begins by default with the cat sprite.

Stage Area - The area where sprite moves independently.

New Sprite buttons - We can create new
sprites using these.

Menu Bar

What is the other name
for a script?

Sprite

Blocks Menu

Stage Area
Script Area

Block Palette

Backdrop
Icons

Add Extension New Sprite Buttons

Figure 7.3: Scrach Window Components
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7. Blocks Palette - Blocks for programming are found here. Drag
the blocks to the script area from the block palette.

8. Add Extension button - Use the Scratch extension button to
add blocks like the music block and pen block that have more
functionality.

DRAWING SHAPES IN SCRATCH

Scratch 3.0 allows you to draw various shapes by stacking blocks one
over another.

Follow the given steps to draw a circle in Scratch 3.0.

Steps:

1. Click on the ‘Add
Extensions’ button. The
pen blocks will then be
added to the blocks menu.

2. Choose the
block from the pen block

menu.

3. Drag the
block from the pen block

menu. Figure 7.4: Drawing Shapes with Pen
4.  Select the Motion block

menu and select these
two

| Is a circle 2D OR 3D shape?

>

blocks . Place these two in the order, as shown in Figure 7.5.

5. Repeat the directions three times of step 4.
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6. Click on the block stack in the script area or the button. You
will have a circle drawn by the sprite.

Figure 7.5: Drawing a Circle with a Pen

(= Kids’ 1Q

Sagar wants to move the sprite by 10 steps . He forgot how to do the same. Suggest
to him the way to accomplish the task.

& Let’s Recall |

o Scratch is freely available on the web.
 The only language a computer can understand is a programming language.

o Scratch is an excellent visual programming language where we can create
interactive narratives, games, and animations.

« The script is a step-by-step instruction that a sprite follows.
 Blocks Palette contains blocks for programming.

o The default mascot of scratch is a cat.

D




| - Upskill 'ntelligence 3/

A. Fill in the blanks

L e, is an excellent visual programming language.

2. Instructions can be given to the computer using ................... blocks.

3. Scratch is freely available on the ..........................

A bar shows the title of the project.

5. Scratch 3.0 allows drawing various shapes by stacking.....................
............................ one over another.

B. Answer the following questions.

1. Whatis Scratch?

2. Write down four features of Scratch.

3.  What is the use of the Menu bar?

4.  What is the use of Blocks Palette?

C. Write ‘T’ for True statements and ‘F’ for False statements.

A computer understands only programming language. (]

A script is also called a sprite. (]

A new project begins by default with the rabbit sprite. (]
)
)

We can create new sprites using new sprite buttons.

AR S e

Sprite performs actions on stage.
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D. Tick the correct answer.

Lo is the area where sprite moves independently.

() a.Sprite () b.Script [ ) c. Stage () d. Menu

2. The cartoon mascot of scratchisa .....................

() a.Rat () b.Penguin (] c. Bird () d.Cat

3. We share our games made using scratch on the ...................

() a. Window [ ] b. Web () c. Computer( | d. Website
4. A tiny graphic that roams around the stage on its own.

() a. Spirit () b. Spite

() c. Sprite () d. None of these

Critical Thinking

A. Number the first three steps in order to draw any shape in Scratch 3.0.
e Choose the pen down block from the pen block menu. )
« Drag the set pen size to 1 block from the pen block menu. )

o Click on the ‘Add Extensions” button. The pen blocks will then be
added to the blocks menu. )

Team Work

Work in pairs. Draw the following shapes in scratch 3.0.
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